
 

Academic Technology Solutions 1 of 6 www.atsolutions.info 

The Very Best of the Microsoft Office Suite 
Visit www.atsolutions.info/classfiles.asp for more technology tools 

Microsoft Word 

Auto-Correct 
Some of the items Word will automatically change for you are: 

• Capitalize first words of sentences and the names of days or months 
• Fix common spelling errors like “cieling” 
• Change :) to ☺ and :( to / and :| to . 
• A divider line from margin to margin (---, ===, ***, ###, and ~~~) 

Tips for working with Auto-Correct 
• Use the Undo command to get rid of Auto-Correct corrections instantly 
• Turn off Auto-Correct options for good or add your own entries: Tools menu | AutoCorrect or 

Auto Correct Options 
• Add your own Auto-Correct shortcuts: Tools menu | Auto-Correct or Auto-Correct Options 
• When creating your own AutoCorrect entries precede them with an = (equal) sign 
• For multiple lines in your AutoCorrect entry you should type the text into any Word document, 

highlight it, and then create the AutoCorrect shortcut 

Generic Text 
Type =rand(10,10) to get 10 paragraphs of 10 sentences each.  You can type any numbers that you like 
within the parenthesis to get a different number of paragraphs/sentences.  If you type in =rand() with 
nothing inside of the parenthesis you will get 3 paragraphs of 3 sentences each.  This is a very good tip 
for teachers who want to teach formatting to your students but don't have an example file. 

Common Keystrokes (on a Mac you would substitute the Apple key instead of Ctrl) 
• Undo = Ctrl+Z 
• Select All = Ctrl+A 
• Line Spacing = Ctrl+1 (single spacing), Ctrl+2 (double spacing), Ctrl+5 (1.5 spacing) 
• Cut = Ctrl+X Copy = Ctrl+C Paste = Ctrl+V 
• New Blank Document = Ctrl+N Save = Ctrl+S Print = Ctrl+P 

Synonyms 
• Right-click on almost any word (Ctrl-click on a Mac) and choose Synonyms from the shortcut 

menu 

Setting the Default Font for Future Documents 
1. Format menu | Font 
2. Choose your favorite font 
3. Set the font at whatever size you think is best 
4. Click on the Default button (lower left-hand corner) 
5. Choose Yes when it asks if you are sure you want to set this as your default  

Default button 
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Adding Artistic Page Borders 
Adding a border to your document makes the document look more professional (and is just fun to do). 

• Format menu | Borders and Shading | Page Border tab | Art drop-down 
• Note: On many printers the bottom page border is cut off.  This is a symptom of the printer you 

are using and not usually due to Word.  Laser-jet printers generally don’t have this problem but 
most ink-jet printers won't print very close to the bottom of the page.  If you don’t have a laser-
printer you can fix the problem by clicking on the Options button (see picture below) and 
choosing Text from the Measure From drop-down box. 

 

 

Using Tabs to Create “Fill in the blank” Lines ______________________________  

1. Add a Left tab far enough away from your text to create a good sized line 
a. To add a tab click in bottom portion of the ruler 

2. Make sure your cursor is on the same line as the tab you just added to the ruler and choose 
Format menu | Tabs 

a. This will open the Tabs dialog box 
3. Choose the #4 Leader 

a. Note!  If you are using multiple tabs on the same line be careful when you’re adding 
leaders.  To add a #4 leader to your second tab you will need to choose that tab from the 
Tab Stop Position area of the Tabs dialog box (see below). 

 
Tip!  Now add your fill in the blank lines as an AutoCorrect entry.  
Highlight the text/lines that you created in the directions above, 
choose AutoCorrect from the Tools menu, type a shortcut 
(preceeded by an equal sign) in the Replace field, click on the 
Add button, then choose OK. 

Be sure to add your 
Leaders to the proper tabs!  

#4 Leader is great for 
“Fill in the blanks”  

#3 Leader is good for 
connecting long-distance 

items like characters/actors 
in a program 

Art drop-down 

Options button used 
to fix bottom borders 

that don't print 
correctly 

Page Border tab 
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Bullets 

Numbering 

Increase Indent (Promote) 

Decrease Indent (Demote) 

Working with Outlines (a.k.a. How to Create Multiple Choice Tests) 
1. To insert basic numbering click on the Numbering button from the Formatting toolbar 
2. To insert bullets click on the Bullets button from the Formatting toolbar 

 
 
 
 
 

3. Click on the Increase Indent button to “Demote” the outline to a lower level 
a. Or press the Tab key to do the same thing (either option works in PowerPoint as well) 

4. Click on the Decrease Indent button to “Promote” the outline to a higher level 
a. Or press Shift+Tab to do the same thing (either option works in PowerPoint as well) 

Working with Google Images and How to Move an Image on the Page 
• Go to www.google.com and click on the link called Images.  Type in your search text and click on 

Search.  Click on a thumbnail (this will take you to the website that contains the image) and then 
click on "See full size image".  Right-click on the picture and Copy it, then switch back to Word 
and Paste it. 

• To move a picture freely: Double-click on the picture, Layout tab | Square 

Microsoft PowerPoint 

Searching for PowerPoint Files Online 
1. Open your preferred Internet Browser and navigate to www.google.com 
2. Click on the Advanced Search link next to the Google search field 
3. Type your search terms into the "Find results with all of the words" field (i.e. 

Abraham Lincoln) 
a. You may want to include other search terms such as "k12" so that the 

program only displays results from other K12 institutions (i.e. Abraham 
Lincoln k12) 

4. Click on the File Format drop-down and change it from "any format" to 
"Microsoft PowerPoint (.ppt)" 

5. Click the Google Search button to display your results 
6. If you find a PowerPoint that you like you can download it to your computer by right-clicking on 

the link (usually the title of the PowerPoint) and choosing Save Target As 
7. Now choose a location that you want to save this presentation to and give it an appropriate name.  

Save the file where you can find it afterward. 
a. Once the file is downloaded all you need do is locate it on your hard drive and double-

click on it to open it 

Great Web Sites for PowerPoint Presentations 
1. www.atsolutions.info/classfiles.asp - links to the following sites and more 
2. http://jc-schools.net/PPTs-la.html 
3. http://www.hardin.k12.ky.us/res_techn/countyjeopardygames.htm - Jeopardy games 
4. http://www.paducah.k12.ky.us/curriculum/PPoint/ - student PowerPoint templates 
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Working with Bulleted Text 
1. Need a sub-bullet?  Click in front of your text (but after the bullet) and press the Tab key on your 

keyboard.  This is called "demoting" the bullet level. 
2. If you want to "promote" your bullet to a higher level press Shift+Tab on your keyboard 

3. Get rid of bullets by clicking on the Bullets button from the Formatting toolbar 
a. This is just an on/off button so if you need your bullets back click on the 

same button (you may have to highlight your text if you have already 
typed in a few lines) 

4. Customize your bullet style by highlighting your text and clicking on Format menu | Bullets and 
Numbering | Customize button 

a. A large variety of different bullets can be found in the Webdings or Wingdings fonts 

Create a Photo Album (a.k.a. How to Procrastinate and Get Away With It) 
This feature is only available in the last few versions of Microsoft PowerPoint and has not been available 
at all on the Mac as of Office 2004. 

1. Transfer pictures from your digital camera and save them to a convenient folder 
a. For file size purposes you may want to size them all to approximately 640 x 480 

2. In PowerPoint go to the Insert menu | Picture | New Photo Album 
3. Click on the Insert Picture from File/Disk button 
4. Navigate to the folder that contains your images, select them all, then click Insert 
5. Choose your options from the Photo Album dialog box and then click Create 
6. At this point you can add music to your presentation, automate your slides with Slide Transitions 

(Slide Show menu | Slide Transition), and then Loop your slide show (Slide Show menu | Set 
Up Show) 

Playing Your Presentation 
1. To play your presentation from the first slide onward choose Slide Show menu | View Show or 
2. To play your presentation from the current slide onward click on the Slide Show button from the 

lower left-hand corner of the PowerPoint window 

 

While Playing Your Presentation 
• Get out of your presentation immediately by pressing the Esc key on your keyboard 
• Black out the screen by pressing the B key on your keyboard 
• White out the screen by pressing the W key on your keyboard 
• Use your cursor as a pen (so you can draw on your slide) by right-clicking your mouse 

(Control+click on the Mac) and choosing Pointer Options 
• Erase your pen marks by pressing the E key on your keyboard 
• Jump to any slide in your presentation by right-clicking your mouse (Control+click on the Mac) 

and choosing Go To | Slide Navigator 
 

Slide Show button 
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Microsoft Excel 

Working with Columns and Rows 
Sizing Columns (works for Rows as well) 

1. Place your cursor between the column headings until your cursor 
changes into a double-headed arrow 

2. Double-click your mouse to size the column to fit, or… 
3. Click-and-drag your mouse to manually size the column 

• Note: Highlight multiple columns to size them all at the same time, then follow the steps listed 
above 

What does it mean when my numbers in a cell show up as #####? 
• Your column isn't wide enough to fit the number in that cell.  You need to size your column wider. 

Inserting Columns (works for Rows as well) 
1. Highlight the number of columns that you want to insert 
2. Insert menu | Columns or right-click (Control+click on a Mac) your mouse in the highlighted 

area and choose Insert 

Make a Note of Data That Seems Odd 
1. Right-click (Control+click on a Mac) and choose Insert Comment 
2. Type the text of your comment 

a. You can also size the comment text box if necessary 
3. Click away from the text box when finished 
4. To edit or delete your comment right-click on the same cell and choose Edit Comment or Delete 

Comment 

Sorting 
Do NOT highlight the entire column before you sort.  This sorts only that one column while all of your 
other columns stay the same! 

• To sort by one column: click in the column you want to sort by and then use these buttons from 

the Standard toolbar:   
• To sort by more than one column: click in your data (it doesn’t matter which column as long as 

you are within your data set and there are no blank rows or columns) then choose Data menu | 
Sort 

• Helps if you have a header row at the top of your data 

Filtering 
Filtering enables you to "weed out" the data you don’t need.  It is also one of the easiest 
ways to use Excel with young children. 

1. To turn on Filters: Data menu | Filter | AutoFilter 
a. Helps if you have a header row at the top of your data 
b. Don’t have any blank rows in your data 
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Printing 
Almost all printing problems can be solved by using the File menu | Page Setup command.  If you 

encounter a problem while printing, this is the 1st place you look to fix it. 

 

 

Stop a Row/Column from Scrolling Out of View 
When you enter data in large spreadsheets it often happens where your headings at the top of the page 
aren’t visible as you scroll down the page.  Data entry can be tough when you don’t know which column is 
which.  This problem can be fixed by using the Freeze Panes command (Window menu | Freeze 
Panes). 

• Using this command will freeze everything on your screen that is above or to the left of your 
cursor 

 

Change to 
Landscape 

Fit to 1 page 
wide by _ tall. 
Remember to 

delete the 
number in the 

Tall field. 

 

Change to Legal 
sized paper 

Use these 2 
settings for your 

headings to 
repeat on every 
PRINTED page 

Check this box 
to print your 

Gridlines 

Choose how 
you want to 
print your 
Comments 
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